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1 About this document

1.1 Used symbols and signal words

Table 1.1: Warning symbols and signal words

Table 1.2: Other symbols

Table 1.3: Terms and abbreviations

Symbol indicating dangers to persons

NOTICE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

Symbol for tips
Text passages with this symbol provide you with further information.


Symbols for action steps
Text passages with this symbol instruct you to perform actions.

BCL Bar code reader

CR CCD based bar code reader
(Code Reader)

DTM Software device manager
(Device Type Manager)

EMC Electromagnetic compatibility

EN European standard

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

FE Functional earth

GUI Graphical User Interface

HID Device class for input devices with which users directly interact
(Human Interface Device)

IO or I/O Input/Output

LED Light Emitting Diode

PLC Programmable Logic Control
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2 Safety
This sensor was developed, manufactured and tested in line with the applicable safety standards. It corre-
sponds to the state of the art.

2.1 Intended use
The CR 55 bar code reader is designed as a stationary scanner with integrated decoder for all common 
bar codes used for automatic object detection.

Areas of application
The CR 55 bar code reader is intended especially for the following areas of application:

• automatic analyzers
• space-critical bar code reading tasks
• automation technology

2.2 Foreseeable misuse
Any use other than that defined under “Intended use” or which goes beyond that use is considered 
improper use.

In particular, use of the device is not permitted in the following cases:
• Rooms with explosive atmospheres
• Circuits relevant to safety
• Operation for medical purposes

2.3 Competent persons
Connection, mounting, commissioning and adjustment of the device must only be carried out by competent 
persons.

Prerequisites for competent persons:
• They have a suitable technical education.
• They are familiar with the rules and regulations for occupational safety and safety at work.
• They are familiar with the technical description of the device.
• They have been instructed by the responsible person on the mounting and operation of the device.

Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant stan-
dards and regulations, certified electricians are able to perform work on electrical systems and indepen-
dently detect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations BGV A3 
(e.g. electrician foreman). In other countries, there are respective regulations that must be observed.

NOTICE
Comply with conditions and regulations!
 Observe the locally applicable legal regulations and the rules of the employer's liability insurance asso-

ciation.

NOTICE
Do not modify or otherwise interfere with the device.
 Do not carry out modifications or otherwise interfere with the device.

The device must not be tampered with and must not be changed in any way.
The device must not be opened. There are no user-serviceable parts inside. 
Repairs must only be performed by Leuze electronic GmbH + Co. KG.
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2.4 Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The device is not being used properly.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Changes (e.g., constructional) are made to the device.
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3 Device description

3.1 Device overview

3.1.1 The CR 55 bar code reader
The bar code reader is a CCD based line scanner with integrated decoder for all commonly used bar 
codes, e.g. 2/5 Interleaved, Code 39, Code 128, EAN etc.
The many possible configurations of the device allow it to be adapted to a multitude of reading tasks. Due 
to the small dimensions of the unit and its large reading field, the bar code reader can also be used in highly 
constrained spaces. 
Information on technical data and characteristics: see chapter 11.

3.1.2 Stand alone operation
The bar code reader is operated as a “stand-alone” single device. It is equipped with a six-wire cable with 
open ends for the electrical connection of the supply voltage, the interface, the switching input and the 
switching output.

3.2 Performance characteristics
• High-performance CCD scanner with front beam exit
• Compact design for simple integration, even in constrained spaces
• Robust metal housing with cable connection
• RS 232 interface, one switching input, one switching output

3.3 Device construction

1 Reading window with front beam exit
2 LED indicators

Figure 3.1: Device construction of the CR 55

3.4 Connection technology
• Cable connection
• Alternative: customer-specific solutions

1

2
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3.5 Display elements
Located on top of the bar code reader are two LEDs that indicates the readiness for operation and the read 
status of the bar code reader.

3.5.1 LED indicators
Two LEDs on the top of the device indicate the device and read status:

Table 3.1: LED indicators

LED State Description

PWR ON (continuous 
light)

Voltage supply OK

GOOD READ ON (continuous 
light)

Reading successful
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4 Mounting
You can fasten the bar code reader at the M2.5 mounting threads.

4.1 Selecting a mounting location

In order to select the right mounting location, several factors must be considered:
• size, orientation, and position tolerance of the bar codes on the objects to be scanned.
• The reading field of the bar code reader in relation to the bar code module width.
• The bar code reader is designed for reading codes in ladder orientation.
• the resulting minimum and maximum reading distance from the respective reading field; see 

figure 11.1.
• alignment of the bar code reader for avoiding reflections.
• distance between bar code reader and host system with respect to the interface.

The best read results are obtained when
• the reading distance lies in the middle area of the reading field.
• there is no direct sunlight and extraneous light is avoided.
• the bar code labels are of good print quality and have good contrast ratios.
• you do not use high-gloss labels.
• the bar code is moved past the reading window with a rotational angle of 10° to 15°.
• the red light beam is narrowed down for its respective reading task in order to avoid reflections on 

shiny components.

α Azimuth angle
β Angle of inclination
γ Angle of rotation

Recommended angle of rotation: γ > 10°
Figure 4.1: Definition of the reading angles

The size of the bar code module influences the maximum reading distance and the width of the                
reading field. Therefore, when selecting a mounting location and/or the bar code label, take into              
account the different reading characteristics of the scanner with various bar code modules.

NOTICE
Observe when choosing the mounting location!
Maintaining the required environmental conditions (temperature, humidity).
 Possible soiling of the reading window due to liquids, abrasion by boxes, or packaging material resi-

dues.
 Lowest possible chance of damage to the scanner by mechanical collision or jammed parts.
 Possible extraneous light influence (no direct sunlight).

With front-side beam exit, the beam exits the bar code reader nearly perpendicular to the reading               
window. The bar code label must be rotated by > 10° to avoid a total reflection of the red light                   
beam in the case of glossy labels.

α

β

γ
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5 Electrical connection

5.1 Voltage supply
The bar code reader is designed for connection to a 5 V supply voltage.

• +5 V DC (red)
• GND (violet)

Available as an accessory is an adapter circuit board with spring terminals and 9-pin SUB-D socket; see 
chapter 12.2 "Accessories". 

• With the adapter circuit board, the conductors of the connection cable can be contacted via the 
spring terminals and connected to the PC via the 9-pin SUB-D socket with an RS 232 interconnec-
tion cable.

• With the adapter circuit board, the voltage supply from 10 … 30 V DC can be fed in via spring termi-
nals or, alternatively, 5 V DC can be fed in via a micro USB connector.

5.2 Pin assignment of the connection cable

5.3 Switching input/Switching output

The bar code reader is provided with a switching input and a switching output.
• The switching input is used to trigger reading.
• The switching output signals successful code reading.

5.3.1 Switching input
By means of the SW IN switching input connection, you can trigger a read process in the standard setting 
(low = active) with the connection SW IN (orange) and GND (violet). We recommend wiring a 2.2 kΩ “pull-
up” resistor as defined cable termination; see figure 5.1.

CAUTION
Safety notices
 The bar code reader is completely sealed and must not be opened. 
 Do not try to open the device under any circumstances, as this voids both degree of protection IP 54 

and the warranty.
 Before connecting the device, be sure that the supply voltage agrees with the value printed on the 

name plate.
 Connection of the device and maintenance work while under voltage must only be carried out by a 

qualified electrician. 
 The power supply unit for the generation of the supply voltage for the bar code reader and the corre-

sponding connection units must have a secure electrical insulation according to IEC 60742 (PELV). 
For UL applications: only for use in “class 2” circuits according to NEC.

 If faults cannot be corrected, the device should be removed from operation and protected against pos-
sible commissioning.

Wire Assignment Description

Red +5V DC Operating voltage 5V DC IN

Violet GND Operating voltage 0V DC / reference ground IN

Black SW OUT Switching output OUT

Orange SW IN Switching input IN

White RS 232 RxD RxD signal line of the RS 232 interface IN

Green RS 232 TxD TxD signal line of the RS 232 interface OUT
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1 Red
2 Orange
3 Violet

Connection version NPN: standard setting (low = active)
Figure 5.1: Wiring example of the trigger input

5.3.2 Switching output
The NPN switching output connection between SW OUT (black) and GND (violet) switches if a code is 
detected against GND.

1 Red
2 Black
3 Violet

Figure 5.2: Switching output

5.4 PC or terminal connection
Via the serial interface, you can configure the bar code reader by means of a PC or terminal. For this, you 
need an RS 232 connection that establishes the RxD, TxD and GND connections between PC and bar 
code reader.
The RS 232 connection can be established in the following ways:

• Direct connection of the bar code reader connection wires to the PC or terminal via its own connec-
tor.

• Connection via an MA-CR adapter circuit board
To simplify the connection of the connection wires to the PC interface, an adapter circuit board (MA-
CR) is available for implementing individual wire contacting to SUB-D, 9-pin; see chapter 12.2.

+ 5 V DC

SW_IN

GND

4.9 … 5.4 V DC 

GND

2.2 k

1

2

3

NOTICE
Maximum loading of the switching output
 Do not load the switching output of the bar code reader with more than 20 mA at +5 … 30 V DC!

+ 5 V DC

OUT

GND
GND

+ 5 … 30 V DC
max. 20 mA !

RL

4.9 … 5.4 V DC 
1

2

3
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1 RS 232 connection
2 CR 50 connection
3 CR 100 or CR 55 connection
4 Molex Micro-Fit, 6-pin
5 USB connection
6 Connection to machine control, PLC, external voltage supply 5 VDC
7 External voltage supply 10 … 30 VDC
8 SWIN DIP switch (level for trigger button; 5 V if the scanner high switching input is active, GND if the 

low input is active)
9 USB/PWR DIP switch (USB position if voltage is supplied via USB; PWR position if voltage is sup-

plied via )
10 Trigger button
11 Status LEDs

Figure 5.3: Connection options for MA-CR adapter circuit board

5.5 Cable lengths and shielding
The maximum cable length is 3 m.
Should a cable extension be necessary, make certain that the cables of the RS 232 interface are shielded.

NOTICE
Using the adapter circuit board
 The MA-CR adapter circuit board is intended only for laboratory and test purposes and is not to be 

used for industrial applications!

12

10 113

4

8

9

5 6 7

7
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6 Configuration and diagnostic software - Sensor Studio
The Sensor Studio configuration software provides a graphical user interface for the operation, configura-
tion and diagnosis of the device via the RS 232 interface.
A device that is not connected to the PC can be configured offline.
Configurations can be saved and reopened as projects for transferring back to the device at a later time.

The Sensor Studio configuration software is designed according to the FDT/DTM concept:

• You make the individual configuration settings for the bar code reader in the Device Type Manager 
(DTM).

• The individual DTM configurations of a project can be called up via the frame application of the Field 
Device Tool (FDT).

• Communication DTM for bar code readers: LeCommInterface
• Device DTM for bar code readers CR 55

Procedure for the installation of the software and hardware:
 Install the Sensor Studio configuration software on the PC.
 Install the communication and device DTM.

Communication and device DTM are included in the LeAnalysisCollectionSetup installation package.
 Create CR 55-DTM in the project tree of the Sensor Studio FDT frame.
 Connect bar code reader to PC; see chapter 5.4
 Activate service interface on bar code reader; see chapter 7.3.2

6.1 System requirements
To use the Sensor Studio configuration software, you need a PC or laptop with the following specifications:

Table 6.1: System requirements for Sensor Studio installation

Only use the Sensor Studio configuration software for products manufactured by          
Leuze electronic.

The Sensor Studio configuration software is offered in the following languages: German, Eng-            
lish, French, Italian and Spanish.

The FDT frame application of the Sensor Studio supports all languages; all languages may not              
be supported in the device DTM (Device Type Manager).

Operating system Windows XP or higher (32 bit, 64 bit)
Windows Vista
Windows 7
Windows 8

Computer • Processor type: 1 GHz or higher
• Serial COM interface
• CD drive
• Main memory (RAM): at least 64 MB
• Keyboard and mouse or touchpad

Graphics card At least 1024 x 768 pixels

Required hard disk 
capacity for 
Sensor Studio and 
communication DTM

35 MB
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6.2 Installing Sensor Studio configuration software

6.2.1 Downloading configuration software
 Call up the Leuze home page: www.leuze.com
 Enter the type designation or part number of the device as the search term.
 The configuration software can be found on the product page for the device under the Downloads tab.

6.2.2 Installing the Sensor Studio FDT frame

 Start the PC. 
 Download the configuration software from the Internet to the PC; see chapter 6.2.1. 

Unpack the installation package.
 Start the SensorStudioSetup.exe file.
 Follow the instructions on the screen.
The Installation Wizard installs the software and places a shortcut on the desktop (  ).

6.2.3 Install the communication DTM and device DTM

Prerequisites:
• An FDT frame is installed on the PC.

 Start the LeAnalysisCollection.exe file from the installation package and follow the instructions on the 
screen.

The installation wizard installs communication DTM and device DTM for CR 55.

Administrator privileges on the PC are necessary for installing Sensor Studio. 

The installation files of the Sensor Studio configuration software must be downloaded from the             
Internet at www.leuze.com.

For subsequent updates, you can find the most recent version of the Sensor Studio installation              
software on the Internet at www.leuze.com.

On delivery, the device is configured for HID operation (Human Interface Device). The device             
can thereby be operated directly via the Windows application.

If you would like to make other settings via the USB interface, you must download the USB driver                 
from the Leuze home page (file name SW_CR5x_Virtual_COM_Port_Drivers...).

NOTICE
First install the software!
 Do not yet connect the device to the PC.

First install the software.

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-                 
lation. 

You can install the communication DTM and the device DTM in the existing FDT frame. Commu-               
nication DTM and device DTM are included in the LeAnalysisCollectionSetup installation pack-           
age.
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6.2.4 Connecting bar code reader to PC
The bar code reader is connected to the PC via the RS 232 interface. For this, you need an RS 232 
connection that establishes the RxD, TxD and GND connections between PC and bar code reader; see 
chapter 5.4.

• You need an RS 232 connection that establishes the RxD, TxD and GND connections between PC 
and bar code reader; see chapter 5.4.

• The 5 V DC voltage supply is to be fed in externally; see chapter 5.1.

6.3 Starting the Sensor Studio
 configuration software

Prerequisites: 
• The bar code reader has been mounted (see chapter 4) and connected (see chapter 5) correctly.
• The bar code reader is connected to the PC via the RS 232 interface (see chapter 6.2.4).
• The service interface is activated on the bar code reader; see chapter 7.3.2
• The Sensor Studio configuration software is installed on the PC (see chapter 6.2 "Installing 

Sensor Studio configuration software").
 Start the Sensor Studio configuration software by double-clicking the Sensor Studio icon (  ).
The mode selection of the Project Wizard is displayed.
 Select the Device selection without communication connection (offline) configuration mode and click on 

[Next].
The Project Wizard displays the device selection list of the configurable devices.

The MA-CR adapter circuit board with spring terminals for connecting the bar code reader, as              
well as 9-pin SUB-D socket for connecting an RS 232 interconnection cable, is available as an               
accessory. An RS 232 interconnection cable to the PC is also available as an accessory; see               
chapter 12 "Ordering information and accessories".

The adapter circuit board requires 10 V … 30 V DC as external voltage supply, which can be fed                  
in via spring terminals. Alternatively, 5 V DC can be fed in via a micro USB connector.
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Figure 6.1: Device selection for bar code reader CR 55

 Select CR 55 in the device selection and click on [Next].
The device manager (DTM) of the connected CR 55 starts with the offline view for the Sensor Studio 
configuration project. 
 Establish the online connection to the connected CR 55.

In the Sensor Studio FDT frame, click on the [Establish connection with device] button (  ).
In the Sensor Studio FDT frame, click on the [Upload parameters to device] button (  ).

The current configuration data is displayed in the device manager (DTM). 
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Figure 6.2: Configuration project: Sensor Studio device manager (DTM) for CR 55

 The menus of the Sensor Studio device manager (DTM) can be used to change or read out the config-
uration of the connected bar code reader.
The user interface of the Sensor Studio device manager (DTM) is largely self-explanatory.
The online help system provides information on the menu items and adjustment parameters. Select the 
Help menu item in the menu [?] (  ).

 Transfer the modified configuration parameters to the device.
If a connection exists, click on the [Download parameters to device] button (  ) on the task bar.

6.4 Exiting Sensor Studio 
After completing the configuration settings, close the Sensor Studio configuration software
 Exit the program via File > Exit.
 Save the configuration settings as a configuration project on the PC.
You can open the configuration project again at later time via File > Open or with the Sensor Studio Project 
Wizard (  ).

6.5 Configuration parameters
In this chapter, you will find information and explanations on the configuration parameters of the device 
manager (DTM) for the CR 55 bar code reader. 

The device manager (DTM) for CR 55 bar code readers of the Sensor Studio configuration software offers 
the following configuration functions:

• General
• Decode; see chapter 6.5.2
• Host Interface; see chapter 6.5.3
• Diagnosis
• Change firmware (Maintenance); see chapter 6.5.4

This chapter does not include a complete description of the Sensor Studio configuration soft-             
ware.

Complete information on the FDT frame menu and on the functions in the device manager (DTM)               
can be found in the online help system.
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6.5.1 General tab

Figure 6.3: General tab

The online help system displays information on the menu items and configuration parameters for             
each function. Select the Help menu item in the menu [?]

Scan Mode Here you can select how a read process is to be activated.

LED Sleep Timeout Setting for the length of time after which the read LED in presentation mode is 
switched off.

Same Code Delay Length of time during which identical codes are output only once during multiple 
reading.

Inverse Code Reading of inverse codes.

General Settings Settings for the integrated buzzer.
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6.5.2 Decode tab

Figure 6.4: Decode tab

Figure 6.5: Standard settings for the Properties window (Symbology Properties) – Decode tab

Code table
(DECODER OVER-
VIEW)

Here, the codes which are to be decoded are set. We recommend enabling only 
the code types which are to actually be read with the corresponding element num-
bers. Codes which are not enabled are not decoded!

Properties
(Symbologies)

Use the […] button to the right of the given code to select the code-specific set-
tings.
Alternatively, the property settings can be selected directly via the navigation tree 
under the [Decode] button.
The properties can be individually set for each code type.
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6.5.3 Host interface tab

Figure 6.6: Host interface tab

Select the desired baud rate, the stop bits, the data bits, the parity and various transmission modes here.
The desired acknowledgment settings are also to be set in this selection window. 

6.5.4 Maintenance / software update

Figure 6.7: Firmware reload

With this tool, new firmware files can first be selected for the CR 50 or CR 55 bar code reader, then they 
can be loaded into the tool and subsequently executed.
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7 Starting up the device - Configuration

7.1 Measures to be performed prior to the initial commissioning

7.2 Starting the device

7.2.1 Interface
Proper function of the interface can be most easily tested in service operation using the serial interface 
with the Sensor Studio configuration software and a notebook computer.

7.2.2 “Online commands”
Using the “Online” commands, important device functions can be checked, e.g. reading activation.

7.2.3 Problems
If a problem occurs that cannot be rectified even after checking all electrical connections and settings on 
the devices and on the host, contact your responsible Leuze electronic subsidiary or Leuze electronic 
customer service, see chapter 10.

7.3 Setting the communication parameters
You have now commissioned the bar code reader. Usually, you will have to configure it before you can 
use it. Using the configuration options offered in the Sensor Studio or by means of the device DTM, the 
bar code reader can be individually configured according to your application. For information on the 
various configuration options, see chapter 6 or refer to the online help.
To operate the bar code reader, it is normally sufficient to set code type and code length in accordance 
with the bar codes that are to be read. 
The setting of code type and code length is usually accomplished by using the Sensor Studio configuration 
software, see chapter 6.
The various parameter sets are explained in brief to understand what is happening during parameter 
setting, see chapter 7.3.1. 
The parameters are then set using the buttons under CONFIGURATION. To transfer the settings to the 
bar code reader, its RS 232 settings must be set to the “Service” operating mode, see chapter 7.3.2.

7.3.1 Parameter sets

factory default parameter set
This parameter set contains the default settings made ex works for all parameters of the bar code reader. 
It is permanently stored in the FLASH ROM of the bar code reader. 

The parameter set with the default settings is loaded into the memory of the bar code reader:
• the first time the device is commissioned after delivery
• following the command “Factory Default” in the configuration program (online command ’PC20’)
• if the checksums of the current parameter set are invalid

Current parameter set
In this parameter set, the current settings for all device parameters are stored. When the bar code reader 
is in operation, the parameter set is stored in the EEPROM of the bar code reader. 

NOTICE

 Please observe the notices for device arrangement, see chapter 4.1.
 If possible, always trigger the scanner with the aid of commands or an external signal transmitter (pho-

toelectric sensor).
 Before commissioning, familiarize yourself with the operation and configuration of the device(s).
 Before connecting the supply voltage, recheck all connections and ensure that they have been prop-

erly made.
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The current set can be stored:
• by copying a valid parameter set from the host computer in the bar code reader
• by an off-line setup using the Sensor Studio configuration software and then subsequently copying to 

the bar code reader

The current parameter set is loaded into the memory of the bar code reader:
• by a parameter command, see chapter  "Parametersatz kopieren"

7.3.2 “Service” operating mode
You can connect a PC or a terminal to the bar code reader via the serial interface and configure the bar 
code reader through this connection; see chapter 5.4 "PC or terminal connection". 
Setting the required parameters is most easily carried out in the “Service” operating mode. 

The operating mode “Service” provides the following defined operating parameters on the RS 232 inter-
face, no matter how the bar code reader is configured for standard operation:

• transmission rate: 9600 baud
• no parity
• 8 data bits
• 1 stop bit

Activating the service interface
The service interface can be activated by holding a defined bar code label (“Service”, see figure 7.1) in 
front of the reading window during power-up (initialization phase).

Figure 7.1: Bar code label “Service”

While the red light is switched on for approx. 1 s after power-up, the “Service” label is to be held up in front 
of the bar code reader at a suitable read distance. When the device is in “Service” mode, the status LED 
flashes.
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8 Online commands

8.1 Overview of commands and parameters
Online commands can be used to send commands directly to the device for control and configuration. For 
this, the bar code reader has to be connected to a computer (host) via the serial interface, see 
chapter 7.3.2.
Information about the transmission protocol: see chapter 0.1.4.

Using the “online” commands you can:
• query the device version.
• activate and deactivate code reading.
• perform a software reset.

Syntax
“Online” commands consist of one or two ASCII characters followed by command parameters.
No separation characters may be entered between the command and the command parameter(s). Both 
small and capitalized letters can be used.
Example:

Notation
Commands, parameters and returned data are enclosed between single quotation marks ’ ’ in the text of 
this manual.
Most online commands are acknowledged by the device and any requested data returned. For commands 
that are not acknowledged, command execution can be observed or monitored directly on the device.

8.2 General online commands
Software version number

Software reset

Command ’H’: Software reset

Parameter ’+’: Activation

Transmitted is: ’H+’

Command ’V’

Description Requests device version information

Parameter none

Acknowledgment Example: ’CR55 Series V 00.91 02.07.2014
The device type appears in the first line followed by the device's version number and 
date. The data which is actually displayed may vary from the values given here.

You can use this command to check whether the communication between PC and scanner is              
functional. If you do not receive an acknowledgment, please check the interface connections or             
the protocol.

Command ’H’

Description Carries out a software reset. The device is restarted and reinitialized, leaving it in the 
same state as when the supply voltage is switched on.

Parameter No

Acknowledgment ’S’ (start signal)
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8.3 Online commands for system control
Activating sensor input

Deactivating sensor input

Command ’+’

Description The command activates decoding.

Parameter none

Acknowledgment none

Command ’-’

Description The command deactivates decoding.

Parameter none

Acknowledgment none
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9 Care, maintenance and disposal
Usually, the bar code reader does not require any maintenance by the operator.

9.1 Cleaning
Clean the glass window of the bar code reader with a soft cloth before mounting.

9.2 Servicing
Repairs to the device must only be carried out by the manufacturer.
 For repairs, contact your responsible Leuze electronic subsidiary or Leuze electronic customer service 

(see chapter 10).

9.3 Disposing
 For disposal observe the applicable national regulations regarding electronic components.

NOTICE
Do not use aggressive cleaning agents!
 Do not use aggressive cleaning agents such as thinner or acetone to clean the device.
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10 Service and support

24-hour on-call service at:
+49 (0) 7021 573-0

Service hotline: 
+49 (0) 7021 573-123
Monday to Friday 8.00 a.m. to 5.00 p.m. (UTC+1)

E-mail:
service.identify@leuze.de

Return address for repairs:
Service center
Leuze electronic GmbH + Co. KG
In der Braike 1
D-73277 Owen / Germany

10.1 What to do should servicing be required?

Customer data (please complete)

Leuze Service fax number:
+49 (0) 7021 573-199

NOTICE
Please use this chapter as a master copy should servicing be required!
 Enter the contact information and fax the form together with your service order to the fax number given 

below.

Device type:

Serial number:

Firmware:

Display messages:

LED states:

Error description:

Company:

Contact person/department:

Phone (direct):

Fax:

Street/No:

ZIP code/City:

Country:
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11 Technical data

11.1 General specifications

Table 11.1:  Optics

Table 11.2:  Electrical equipment

Table 11.3:  Mechanics

Light source LED 617 nm (visible red light)

Wavelength 617 nm

Beam exit front

Scanning rate typically 330 scans/s

Module width 5 … 20 mil
127 … 500 µm (distance dependent)

Reading distance see chapter 11.2 "Reading fields"

Reading field opening see chapter 11.2 "Reading fields"

Code types 2/5 Interleaved, Code 39, Code 128, EAN 128, 
EAN/UPC, EAN Addendum, Codabar, Code 93

Interface type RS 232 or USB 2.0 (virtual COM, HID)

Baud rate 300 … 115200 baud

Supply voltage 4.5 … 5.5 V DC, Safety Class III - PELV (Protec-
tive Extra Low Voltage)
Notice:
For UL applications: only for use in “Class 2” cir-
cuits according to NEC

Current consumption max. 120 mA 

Ports 1 switching input 5 V DC
1 switching output 5 … 30 V, 20 mA

LEDs 1 device status
1 read status

Degree of protection IP 54

Connection type RS 232: fixed cable 2 m long, 6 x 0.081 mm2 
(AWG 28)
USB: fixed cable, 1.8 m long

Weight 45 g (without cable)

Dimensions (H x W x D)  18.3 x 31x 45.5 mm

Housing metal, die-cast aluminum 
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Table 11.4: Environmental data

11.2 Reading fields

1 5 mil (0.127 mm), Code 128
2 6.5 mil (0.165 mm), Code 128
3 8 mil (0.203 mm), Code 128
4 10 mil (0.254 mm), Code 128
5 20 mil (0.508 mm), Code 128

Figure 11.1: CR 55 read field

Ambient temp. (operation/storage) 0 °C … +50 °C/-20 °C … +60 °C

Air humidity max. 90 % rel. humidity, non-condensing 

Electromagnetic compatibility EN 55022
IEC 62471

Conformity CE, FCC

Certifications UL 60950-1
CSA C22.2 No. 60950-1-07

Please note that the actual reading fields are also influenced by factors such as labeling material,               
printing quality, scanning angle, printing contrast etc., and may thus deviate from the reading             
fields specified here. The origin of the read distance always refers to the front edge of the housing                 
of the beam exit.
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11.3 Dimensioned drawings

all dimensions in mm
Figure 11.2: Dimensioned drawing of CR 55 with front beam exit
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12 Ordering information and accessories

12.1 Type overview

Table 12.1: Part numbers

12.2 Accessories

Table 12.2: Accessories

Part no. Part designation Description

50126080 CR55M2/R2 CCD line scanner, RS 232 interface, fixed cable, 
2 m

50127723 CR55M2/UB-1800-S6 CCD line scanner, USB interface, fixed cable, 
1.8 m

Part no. Part designation Description

50128204 MA-CR Adapter circuit board with spring terminals and 9-
pin SUB-D socket

50113396 KB DSub-9P-3000 RS 232 interconnection cable, cable length 3 m

USB driver for configuring the CR 55 scanner
Download at www.leuze.com

  

Sensor Studio configuration software
Download at www.leuze.com
see chapter 6.2.1 "Downloading configuration soft-
ware"

Sensor Studio designed according to the FDT/
DTM concept. Contains: communication DTM and 
device DTM
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13 EC Declaration of Conformity
The bar code readers of the CR 55 series have been developed and manufactured in accordance with the 
applicable European standards and directives.
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14 Appendix

14.1 Bar code samples

Module 0.3
Figure 14.1: Code type 01: Interleaved 2 of 5

Module 0.3
Figure 14.2: Code type 02: Code 39

Module 0.3
Figure 14.3: Code type 11: Codabar

Module 0.3
Figure 14.4: Code 128

Module 0.3
Figure 14.5: Code type 08: EAN 128

SC 2
Figure 14.6: Code type 06: UPC-A

SC 3
Figure 14.7: Code type 07: EAN 8
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SC 0                    S
Figure 14.8: Code type 10: EAN 13 Add-on
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